Contents

Introduction ................................................................................................................................................. 2

Symbols and conventions ............................................................................................................................. 2
Contacting Microsoft Dynamics GP Technical Support ........................................................................... 2
Send us your documentation comments .................................................................................................. 3

Chapter 1: Deployment configurations ......................................................................................................... 5

Standard deployment model .......................................................................................................................... 5
Scale-out deployment model .......................................................................................................................... 6

Chapter 2: Reporting Services checklists .................................................................................................... 9

Reporting Services 2008 Native mode setup checklist ............................................................................... 9
Reporting Services 2008 R2 Native mode setup checklist ........................................................................ 10
Reporting Services 2008 R2 for Microsoft SharePoint 2010 setup checklist ......................................... 11
Reporting Services 2012 Native mode setup checklist ........................................................................... 12
Reporting Services 2012 for Microsoft SharePoint 2010 setup checklist .............................................. 13

Chapter 3: Installing Reporting Services 2008 .......................................................................................... 15

Requirements ........................................................................................................................................... 15
Configuring Web Server (IIS) for Reporting Services 2008 ................................................................... 15
Installing Reporting Services 2008 .......................................................................................................... 17
Configuring Reporting Services 2008 ....................................................................................................... 19
Starting Report Manager ........................................................................................................................... 20
Starting Report Server ............................................................................................................................... 20
Installing SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint Technologies ... 20
Activating Report Server Integration ......................................................................................................... 21
Configuring Report Server Integration ...................................................................................................... 21

Chapter 4: Installing Reporting Services 2008 R2 .................................................................................. 23

Requirements ........................................................................................................................................... 23
Microsoft Dynamics GP CRM requirements ............................................................................................... 23
Configuring Web Server (IIS) role for Reporting Services 2008 R2 ....................................................... 23
Installing Reporting Services 2008 R2 ............................................................................................... 26
Configuring Reporting Services 2008 R2 ............................................................................................... 27
Starting Report Manager ........................................................................................................................... 28
Starting Report Server ............................................................................................................................... 28
Creating a Reports site in Microsoft SharePoint 2010 ............................................................................. 28
Creating a Reports Library in Microsoft SharePoint 2010 .................................................................... 29
Installing SQL Server Reporting Services Add-in for SharePoint 2010 Technologies .......................... 29
Configuring Reporting Services Integration ............................................................................................. 30

Chapter 5: Installing Reporting Services 2012 ........................................................................................ 31

Requirements ........................................................................................................................................... 31
Microsoft Dynamics GP CRM requirements ............................................................................................... 31
Configuring Web Server (IIS) role for Reporting Services 2012 ............................................................ 32
Installing Reporting Services 2012 .......................................................................................................... 35
Configuring Reporting Services 2012 in Native mode .......................................................................... 36
The SQL Server® Reporting Services Guide describes how to install and configure Microsoft® SQL Server Reporting Services, how to deploy predefined reports that are included in Microsoft Dynamics® GP to a server or to a Microsoft SharePoint® reports library using the Reporting Tools Setup window, and how to set up security for reports.

Review the following table for the version of SQL Server Reporting Services and the report type available for that version.

<table>
<thead>
<tr>
<th>SQL Server Reporting Services version</th>
<th>Report type available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting Services 2008</td>
<td>SQL Server Reporting Services reports</td>
</tr>
<tr>
<td>Reporting Services 2008 R2</td>
<td>Charts and key performance indicators (KPIs)</td>
</tr>
<tr>
<td>Reporting Services 2012</td>
<td></td>
</tr>
<tr>
<td>Reporting Services 2008 R2</td>
<td>Map charts</td>
</tr>
<tr>
<td>Reporting Services 2012</td>
<td></td>
</tr>
</tbody>
</table>

This introduction is divided into the following sections:

- Symbols and conventions
- Contacting Microsoft Dynamics GP Technical Support
- Send us your documentation comments

Symbols and conventions

This documentation uses the following symbols and conventions to make specific types of information stand out.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Light bulb]</td>
<td>The light bulb symbol indicates helpful tips, shortcuts and suggestions.</td>
</tr>
<tr>
<td>![Warning]</td>
<td>The warning symbol indicates situations you should be especially aware of when completing tasks.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a batch</td>
<td>Italicized type indicates the name of a section or procedure.</td>
</tr>
<tr>
<td>File &gt;&gt; Print or File &gt; Print</td>
<td>The (&gt;&gt;) or (&gt;) symbol indicates a sequence of actions, such as selecting items from a menu or toolbar, or pressing buttons in a window. This example directs you to go to the File menu and choose Print.</td>
</tr>
<tr>
<td>TAB or ENTER</td>
<td>Small capital letters indicate a key or a key sequence.</td>
</tr>
</tbody>
</table>

Contacting Microsoft Dynamics GP Technical Support

If you have any questions regarding Reporting Services with Microsoft Dynamics GP, you can contact Microsoft Dynamics GP Technical Support using one of the following methods:
• Log on to the Microsoft Dynamics GP Support Web site (https://mbs.microsoft.com/customersource/support/) and choose New Support Requests under Assisted Support to send an eSupport request.

• Telephone 1-888-477-7877 (U.S. and Canada only) or +1-701-281-0555.

**Send us your documentation comments**

We welcome comments regarding the usefulness of the Microsoft Dynamics GP documentation. If you have specific suggestions or find any errors in this manual, send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation Feedback link, which is located at the bottom of each Help topic.

*Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use them freely.*
Chapter 1: Deployment configurations

There are several ways the Reporting Services can be deployed. You can use a standard deployment model or a scale-out deployment model.

You must use Kerberos Authentication with Reporting Services if you are using Windows® Authentication and your configuration has SQL Server on one computer and the Web server on another computer. For more information see How to use Kerberos authentication in SQL Server (http://support.microsoft.com/kb/319723/en-us).

This chapter includes the following sections.

- Standard deployment model
- Scale-out deployment model

Standard deployment model

A standard deployment model is made up of a single report server instance that uses a local or remote SQL Server database engine to host the report server database.

You should consider processing resource and disk space availability when choosing where to host the report server database are processing resources and disk space availability. Both the report server and the database engine compete for CPU time, memory, and disk access. Some report server operations are resource intensive. For example, a report server attempts to use all available memory for report rendering operations.

Although the use of a report server database may be small initially, disk space requirements can grow significantly at run time depending on how you run reports and the number of users accessing the report server.

Single-server configuration

The following diagram shows the standard deployment model of single-server configuration. A single-server configuration is where the report server database is installed locally so that all server components are on the same computer.
Separate server configuration
The following diagram shows the standard deployment model where the report server database is located on a remote server.

Scale-out deployment model
You can deploy Reporting Services in a scale-out deployment. A report server scale-out deployment model is made up of multiple report servers that share a single report server database. You can run the report servers in a server cluster. The database can be installed on a remote SQL Server instance or locally with one of the report servers.

To run the report servers as a single virtual server or to use Network Load Balancing (NLB), you must use software and tools that support that functionality. Reporting Services does not provide server cluster or virtual server management.
The following diagram shows multiple report servers and report server databases deployed in separate server clusters.
Chapter 2: Reporting Services checklists

Use one of the following checklists to install and set up Reporting Services. Next to each step in a checklist is a reference to where you can find more detailed information.

This chapter includes the following sections.

- Reporting Services 2008 Native mode setup checklist
- Reporting Services 2008 R2 Native mode setup checklist
- Reporting Services 2008 R2 for Microsoft SharePoint 2010 setup checklist
- Reporting Services 2012 Native mode setup checklist
- Reporting Services 2012 for Microsoft SharePoint 2010 setup checklist

Reporting Services 2008 Native mode setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2008 in the Native mode.

<table>
<thead>
<tr>
<th>Step</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Select a Reporting Services deployment configuration.</td>
</tr>
<tr>
<td>2.</td>
<td>Verify system requirements.</td>
</tr>
<tr>
<td>3.</td>
<td>Configure the Web Server (IIS) role.</td>
</tr>
<tr>
<td>4.</td>
<td>Install Reporting Services 2008. The configuration options available depend whether you are installing Reporting Services at the same time as other SQL Server components or are installing Reporting Services as an additional component.</td>
</tr>
<tr>
<td>5.</td>
<td>Configure Reporting Services 2008.</td>
</tr>
<tr>
<td>6.</td>
<td>Verify that you can connect to the Report Manager.</td>
</tr>
</tbody>
</table>
# Reporting Services 2008 R2 Native mode setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2008 R2 in the Native mode.

<table>
<thead>
<tr>
<th>Step</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select a Reporting Services deployment configuration.</td>
<td>Chapter 1, “Deployment configurations.”</td>
</tr>
<tr>
<td>2. Verify system requirements.</td>
<td>Requirements on page 23</td>
</tr>
<tr>
<td>3. Configure the Web Server (IIS) role.</td>
<td>Configuring Web Server (IIS) role for Reporting Services 2008 R2 on page 23</td>
</tr>
<tr>
<td>4. Install Reporting Services 2008 R2. The configuration options available depend whether you are installing Reporting Services at the same time as other SQL Server components or are installing Reporting Services as an additional component.</td>
<td>During the Reporting Services installation, you can specify one of the following options as the type of Reporting Services installation to create.</td>
</tr>
<tr>
<td><strong>Native mode default configuration</strong></td>
<td>Installs a report server instance using the default values for the report server databases, service account, and URL reservations. The report server instance is ready to use after installation is complete. The report server database is created using a local Database Engine instance, and a report server is configured to use default values. Note: Microsoft Dynamics CRM supports only the native mode of deployment of Reporting Services 2008 R2.</td>
</tr>
<tr>
<td><strong>Unconfigured Reporting Services installation</strong></td>
<td>Installs the report server program files, creates the Report Server service account, and registers the report server Windows Management Instrumentation (WMI) provider. After the installation is complete, you must create the report server database and configure the report server before it can be used. Installing Reporting Services 2008 R2 on page 26 This procedure assumes that you have already installed Microsoft SQL Server 2008 R2, but not Reporting Services. These instructions are for installing Reporting Services as a single-server configuration.</td>
</tr>
<tr>
<td>5. Configure Reporting Services 2008 R2.</td>
<td>Configuring Reporting Services 2008 R2 on page 27 This step is required if you selected the Unconfigured Reporting Services installation option when installing Reporting Services.</td>
</tr>
<tr>
<td>6. Verify that you can connect to the Report Manager.</td>
<td>Starting Report Manager on page 28</td>
</tr>
<tr>
<td>7. Deploy predefined Reporting Services reports.</td>
<td>Chapter 6, “Deploying Reporting Services reports.” Use the Reporting Tools Setup window to select the configuration mode, to define locations of the Report Server, the Report Manager, or the Reports Library, and deploy reports. If you are using Microsoft Dynamics CRM 2011 or later, you can enter location of the CRM services and the name of the organization. In Microsoft Dynamics GP, open the Reporting Tools Setup window. Administration &gt; Setup &gt; System &gt; Reporting Tools Setup</td>
</tr>
</tbody>
</table>
Reporting Services 2008 R2 for Microsoft SharePoint 2010 setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2008 R2 in the SharePoint Integrated mode, and creating a site collection and reports library for Microsoft SharePoint 2010.

<table>
<thead>
<tr>
<th>Step</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Select a Reporting Services deployment configuration.</td>
</tr>
<tr>
<td>2.</td>
<td>Verify system requirements.</td>
</tr>
<tr>
<td>3.</td>
<td>Configure Web Server (IIS) role.</td>
</tr>
</tbody>
</table>
| 4. | Install Reporting Services 2008 R2. The configuration options available depend whether you are installing Reporting Services at the same time as other SQL Server components or are installing Reporting Services as an additional component. During the Reporting Services installation, you can specify one of the following options as the type of Reporting Services installation to create.  
  
  **SharePoint Integrated mode default configuration** Installs a report server instance using the default values for the report server databases, service account, and URL reservations. The report server database is created in a format that supports content storage and addressing from a SharePoint site.  
  
  Note: Microsoft Dynamics CRM supports only the native mode of deployment of Reporting Services 2008 R2.  
  
  **Unconfigured Reporting Services installation** Installs the report server program files, creates the Report Server service account, and registers the report server Windows Management Instrumentation (WMI) provider. After the installation is complete, you must create the report server database and configure the report server before it can be used.  
  
  During the Reporting Services installation, you can specify one of the following options as the type of Reporting Services installation to create.  
  
  **SharePoint Integrated mode default configuration** Installs a report server instance using the default values for the report server databases, service account, and URL reservations. The report server database is created in a format that supports content storage and addressing from a SharePoint site.  
  
  Note: Microsoft Dynamics CRM supports only the native mode of deployment of Reporting Services 2008 R2.  
  
  **Unconfigured Reporting Services installation** Installs the report server program files, creates the Report Server service account, and registers the report server Windows Management Instrumentation (WMI) provider. After the installation is complete, you must create the report server database and configure the report server before it can be used. |
| 6. | Verify that you can connect to the Report Server. |
| 7. | Create a Reports site. |
| 8. | Create a Reports Library. |
| 9. | Install the SQL Server Reporting Services SharePoint 2010 Add-in. The SQL Server Reporting Services SharePoint 2010 Add-in is installed as a prerequisite for SharePoint Foundation and SharePoint Server if Reporting Services is already installed. If you install Reporting Services 2008 after installing SharePoint, you can use the Microsoft SharePoint 2010 Products Preparation Tool to install the add-in. |
  
  Use the Reporting Tools Setup window to select the configuration mode, to define locations of the Report Server, or the Reports Library, and deploy reports. |
| 12. | Set up security for Reporting Services. |
# Reporting Services 2012 Native mode setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2012 in the Native mode.

<table>
<thead>
<tr>
<th>Step</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select a Reporting Services deployment configuration.</td>
<td>Chapter 1, “Deployment configurations.”</td>
</tr>
<tr>
<td>2. Verify system requirements.</td>
<td>Requirements on page 31</td>
</tr>
<tr>
<td>3. Configure the Web Server (IIS) role.</td>
<td>Configuring Web Server (IIS) role for Reporting Services 2012 on page 32</td>
</tr>
</tbody>
</table>
| 4. Install Reporting Services 2012. The configuration options available depend whether you are installing Reporting Services at the same time as other SQL Server components or are installing Reporting Services as an additional component. | During the Reporting Services installation, you can specify one of the following options as the type of Reporting Services installation to create.  

**Install and configure**  Installs a report server instance using the default values for the report server databases, service account, and URL reservations. The report server instance is ready to use after installation is complete. The report server database is created using a local Database Engine instance, and a report server is configured to use default values.  

Note: Microsoft Dynamics CRM supports only the native mode of deployment of Reporting Services 2012.  

**Install only**  Installs the report server program files, creates the Report Server service account, and registers the report server Windows Management Instrumentation (WMI) provider. After the installation is complete, you must create the report server database and configure the report server before it can be used.  

Installing Reporting Services 2012 on page 35  
This procedure assumes that you have already installed Microsoft SQL Server 2012, but not Reporting Services. These instructions are for installing Reporting Services as a single-server configuration. |
This step is required if you selected the **Install only** option when installing Reporting Services. |
| 6. Verify that you can connect to the Report Manager. | Starting Report Manager on page 37 |
| 7. Deploy predefined Reporting Services reports. | Chapter 6, “Deploying Reporting Services reports.”  
Use the Reporting Tools Setup window to select the configuration mode, to define locations of the Report Server, the Report Manager, or the Reports Library, and deploy reports. If you are using Microsoft Dynamics CRM 2011 or later, you can enter location of the CRM services and the name of the organization. In Microsoft Dynamics GP, open the Reporting Tools Setup window. (Administration > Setup > System > Reporting Tools Setup) |
## Reporting Services 2012 for Microsoft SharePoint 2010 setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2012 in the SharePoint Integrated mode, and creating a site collection and reports library for Microsoft SharePoint 2010.

<table>
<thead>
<tr>
<th>Step</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select a Reporting Services deployment configuration.</td>
<td>Chapter 1, “Deployment configurations.”</td>
</tr>
<tr>
<td>2. Verify system requirements.</td>
<td>Requirements on page 31</td>
</tr>
<tr>
<td>3. Configure Web Server (IIS) role.</td>
<td>Configuring Web Server (IIS) role for Reporting Services 2012 on page 32</td>
</tr>
</tbody>
</table>
| 4. Install Reporting Services 2012. | During the Reporting Services installation for the SharePoint Integrated mode, the report server program files are installed. After the installation is complete, you must use the SharePoint Central Administration to complete the configuration. Verify the SQL Server Reporting Services service is started and create at least one SQL Server Reporting Services service application.  
  
  **Note:** Microsoft Dynamics CRM supports only the native mode of deployment of Reporting Services 2012.  
  
  Installing Reporting Services 2012 on page 35  
  This procedure assumes that you have already installed Microsoft SQL Server 2012, but not Reporting Services. These instructions are for installing Reporting Services as a single-server configuration. |
| 5. Configure Reporting Services 2012 in SharePoint Integrated mode. | Installing the Reporting Services SharePoint service on page 38  
  Starting the Reporting Services SharePoint service on page 38  
  Creating a Reporting Services service application on page 38  
  This step is required. |
| 7. Create a Reports site. | Creating a Reports site in Microsoft SharePoint 2010 on page 39 |
| 8. Create a Reports Library. | Creating a Reports Library in Microsoft SharePoint 2010 on page 40 |
| 10. Configure Report Services Integration. | Configuring Reporting Services Integration on page 41 |
| 11. Activate Claims to Windows Token Service | Activating the Claims to Windows Token Service on page 41 |
  In Microsoft Dynamics GP, open the Reporting Tools Setup window. (Administration > Setup > System > Reporting Tools Setup)  
  
  Use the Reporting Tools Setup window to select the configuration mode, to define locations of the Report Server, or the Reports Library, and deploy reports. |
Chapter 3: Installing Reporting Services 2008

Use the information in this chapter to install and configure Reporting Services 2008. This chapter contains the following sections:

- Requirements
- Configuring Web Server (IIS) for Reporting Services 2008
- Installing Reporting Services 2008
- Configuring Reporting Services 2008
- Starting Report Manager
- Starting Report Server
- Installing SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint Technologies
- Activating Report Server Integration
- Configuring Report Server Integration

Requirements

The following components must be installed before you can install SQL Server Reporting Services 2008 to use with Microsoft Dynamics GP.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Operating system         | Server: Windows Server 2008 with latest service pack  
| 32-bit and 64-bit supported | Windows Server 2008 R2 with latest service pack  
| Client                   | Windows 7 with latest service pack |
| Database                 | Microsoft SQL Server 2008 with service pack 1 or later  
|                          | Microsoft SQL Server 2008 R2                         |
| SharePoint               | Microsoft SharePoint Foundation 2010  
|                          | Microsoft SharePoint Server 2010                      |
| Web browser              | Internet Explorer 9                              
|                          | Internet Explorer 8                               |
| Microsoft Dynamics GP    | Microsoft Dynamics GP 2013 or later              |

Configuring Web Server (IIS) for Reporting Services 2008

Internet Information Services (IIS) must be installed before Reporting Services because a Web site and a Web services are created during the Reporting Services installation. IIS is a set of Internet-based services for servers using Microsoft Windows. IIS hosts Web sites and Web services.

To configure Web Server (IIS) for Windows Server 2008:

1. Open the Server Manager.  
   (Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click Next to continue.
4. In the list of available roles, select the **Web Server (IIS)** role.

5. In the message dialog, click **Add Required Features** to add features required for the Web Server (IIS) role.

6. Click **Next** to continue.

7. Review the information about the Web Server (IIS) role. Click **Next** to continue.

8. In the Select Role Services window, select the following subcomponents for the Web Server role service.

9. Click **Next**.

10. Review the installation messages, and then click **Install**.

11. After you have viewed the installation results, click **Close**.

12. Select the **Features** node in the Server Manager. The currently installed roles are displayed.

**To configure Web Server (IIS) for Windows Server 2008 R2:**

1. Open the Server Manager. (Start > Administrative Tools > Server Manager)

2. Select the **Roles** node in the Server Manager. The currently installed roles are displayed.

3. In the **Action** menu, choose **Add Roles**. The Add Roles Wizard appears. Click **Next** to continue.
4. In the list of available roles, select the **Web Server (IIS)** role.

5. In the message dialog, click **Add Required Features** to add features required for the Web Server (IIS) role.

6. Click **Next** to continue.

7. Review the information about the Web Server (IIS) role. Click **Next** to continue.

8. In the Select Role Services window, select the following subcomponents for the Web Server role service.

<table>
<thead>
<tr>
<th>Role Service component</th>
<th>Required subcomponent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common HTTP Features</td>
<td>Static Content</td>
</tr>
<tr>
<td></td>
<td>Default Document</td>
</tr>
<tr>
<td></td>
<td>Directory Browsing</td>
</tr>
<tr>
<td></td>
<td>HTTP Errors</td>
</tr>
<tr>
<td></td>
<td>HTTP Redirection</td>
</tr>
<tr>
<td>Application Development</td>
<td>ASP.Net</td>
</tr>
<tr>
<td></td>
<td>.NET Extensibility</td>
</tr>
<tr>
<td></td>
<td>ISAPI Extensions</td>
</tr>
<tr>
<td></td>
<td>ISAPI Filters</td>
</tr>
<tr>
<td></td>
<td>Server Side includes</td>
</tr>
<tr>
<td>Health and Diagnostics</td>
<td>HTTP Logging</td>
</tr>
<tr>
<td></td>
<td>Request Monitor</td>
</tr>
<tr>
<td>Security</td>
<td>Basic Authorization</td>
</tr>
<tr>
<td></td>
<td>Windows Authorization</td>
</tr>
<tr>
<td></td>
<td>Digest Authorization</td>
</tr>
<tr>
<td></td>
<td>Request Filtering</td>
</tr>
<tr>
<td>Performance</td>
<td>Static Content Compression</td>
</tr>
<tr>
<td>Management Tools</td>
<td>IIS Management Console</td>
</tr>
<tr>
<td></td>
<td>IIS 6 Management Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Metabase Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 WMI Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Scripting Tools</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Management Console</td>
</tr>
</tbody>
</table>

9. Click **Next**.

10. Review the installation messages, and then click **Install**.

11. After you have viewed the installation results, click **Close**.

12. Select the **Features** node in the Server Manager. The currently installed roles are displayed.

13. Be sure that .NET Framework 3.5 Features is installed if you are using Windows Server 2008 R2. If it isn’t, use Add Features in Server Manager to add the features.

### Installing Reporting Services 2008

You can follow the instructions in this section if you have not yet installed Microsoft SQL Server Reporting Services. This procedure assumes that you have already installed Microsoft SQL Server 2008, but not Reporting Services. These instructions are for installing Reporting Services as a single-server configuration. A single-server
configuration is where the report server database is installed locally so that all server components are on the same computer. For more information about configurations, see Chapter 1, “Deployment configurations.”

When running the SQL Server installation program, you must be logged in as a member of the local system administrators group. Your SQL Server login account must have administrator permissions in SQL Server so you can create logins, roles and databases, and assign roles to logins.

The SQL Server that hosts your Microsoft Dynamics GP data must be using mixed-mode authentication. (Mixed-mode authentication allows you to use either Windows Authentication or SQL Authentication to access the SQL Server.)

To install Reporting Services 2008:
1. Insert the SQL Server 2008 media. The main SQL Server installation screen should appear. If you do not see this screen, browse the media and double-click the setup.exe file.

2. Click Yes to make changes to your computer if you are using User Account Control.

3. In the SQL Server Installation Center, click Installation.

4. Click New SQL Server stand-alone installation or add features to an existing installation.

5. In the Setup Support Rules window, click OK.

6. In the Setup Support Files window, click Install.

7. Your computer is scanned for conditions that may cause possible installation problems. To proceed with the installation, click Next.

8. In the Installation Type window, select Add features to an existing instance of SQL Server 2008 and click Next.

9. In the Feature Selection window, select Reporting Services and any other feature you want to install. Click Next.

10. In the Disk Requirements window, click Next.

11. In the Server Configuration window, enter the Account Name. Click Next.

12. In the Reporting Services Configuration window, click Next.

You will have to configure the report server using the Reporting Services Configuration Manager after installing Reporting Services.

13. In the Error and Usage Reporting window, click Next.


15. In the Ready to Install window, click Install.

16. The Installation Progress window appears, allowing you to view the status of the installation. Click Next after the installation is completed.
17. In the Complete window, click **Close** to exit the installation wizard.

18. Restart the computer if you are instructed to do so.

### Configuring Reporting Services 2008

Use the Report Server Configuration Manager to configure and start Reporting Services in Native mode. The Report Server Configuration Manager has a number of pages that you can use to configure Reporting Services.

#### To configure Reporting Services 2008:

1. Start Reporting Services Configuration Manager.
   
   (Start > All Programs > Microsoft SQL Server 2008 > Configuration Tools > Reporting Services Configuration Manager)

2. Click **Yes** to make changes to your computer if you are using User Account Control.

3. Enter the name of a server and select an instance to connect to a report server instance. Click **Connect**.
   
   *If you installed Reporting Services on a Web server where SQL Server isn’t installed, connect to the reporting server and not the SQL server.*

4. If Reporting Services isn’t running, click the **Start** button in the Report Server Status page. The Report Server Status page displays status information about the instance that you’ve selected.

5. In the navigation pane, click **Service Account** to open the page. Be sure that the **Use the built-in account** option is selected.

6. In the navigation pane, click **Web Service URL** to open the Web Service URL page. This page allows you to view and change the name of the virtual directory used by the Reporting Services Web service.

7. Click **Apply** to create a new virtual directory.

8. In the navigation pane, click **Database** to open the Report Server Database page.

9. Click **Change Database**.

10. Select to create a new report server database, and click **Next**.

11. Select Authentication type and specify the user name and password, if necessary. Click **Next**.

12. Specify the database name and specify the Report Server mode. Click **Next**.

13. Select Authentication type and specify the user name and password for your credentials, if necessary. Click **Next**.

14. Verify the database information. Click **Next**.

15. After the database is configured, click **Finish**.
16. If you selected Native mode for your report server database, click Report Manager URL to open the Report Manager URL page in the navigation pane. Click Apply.

17. Click Exit.

Starting Report Manager

Report Manager is installed during setup on the same computer as the report server. If you selected Native mode for your report server database, you should verify that you can connect to the Report Manager.

To start Report Manager:
1. Open Microsoft Internet Explorer.
2. In the address bar of the Web browser, type the Report Manager URL. By default, the URL is http://<ComputerName>/Reports

Starting Report Server

If you selected the SharePoint Integrated mode for your report server database, you should verify that you can connect to the Report Server.

To start Report Server:
1. Open Microsoft Internet Explorer.
2. In the address bar of the Web browser, type the Report Manager URL. By default, the URL is http://<ComputerName>/ReportServer.

Installing SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint Technologies

The SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint Technologies allows you to integrate your reporting environment with Microsoft SharePoint. Once you install the add-in and configure your servers for integration, you can publish Reporting Services reports to a reports library and then view and manage the reports from a SharePoint site.

Installing the SQL Server 2008 Reporting Services Add-in will activate the report server integration feature for all existing site collections. If the root site is not enabled or if you do not have a site collection defined when the Reporting Services Add-in is installed, you must activate the report server integration settings manually.

To install the SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint Technologies:
2. In the welcome window, click Next.
3. Accept the license agreement.
4. Enter registration information and click Next.
5. Click Install.

6. After the add-in is installed, click Finish.

**Activating Report Server Integration**

The Report Server Integration feature is automatically activated after you install the Microsoft SQL Server 2008 Reporting Services Add-in for SharePoint products. By default, the Reporting Services Add-in is activated for the root site collection of the local SharePoint Web application. If the root site is not enabled or if you do not have a site collection defined when the Reporting Services Add-in is installed, you must activate the report server integration settings manually.

If the Reporting Server Integration feature does not appear in the site collection feature list, the Reporting Services Add-in is not installed. To verify installation, view the list of installed applications in Microsoft Windows Control Panel. If the Reporting Services Add-in is installed, follow the instructions in this topic to activate the feature.

**To activate the Report Server Integration feature:**
1. Type http://<ServerName> in the address field of Internet Explorer.

   Go to the Site Settings page (Site Actions > Site Settings) for the top-level web site.

2. Under Site Collection Administration in the Site Settings page, click Site collection features.

3. Be sure that the Report Server Integration Feature is activated.

**Configuring Report Server Integration**

You must specify integration settings that determine the connection between SharePoint and a report server. The settings that you specify are stored in the configuration database. You must be an administrator on the SharePoint farm to configure report server integration. You also must have a target report server that is already connected to a report server database that was created for SharePoint integrated.

If you don’t have the SQL Server Reporting Services SharePoint Add-in installed, the configuration pages and general integration are not available.

**To configure Report Services Integration:**
1. Open SharePoint Central Administration. (Start > Administrative Tools > SharePoint Central 3.0 Administration)

2. Click Application Management.

3. Under the Reporting Services heading, click Grant database access.

4. In the Grant Database Access page, specify the server name and the instance. Click OK.

5. Enter your credentials and click OK.
6. Under the **Reporting Services** heading, click **Manage integration settings**.

7. In the Reporting Services Integration page, specify the URL for the report server web service. For example, `http://<ServerName>/ReportServer`

8. Select the authentication mode. Click **OK**.
Chapter 4: Installing Reporting Services 2008 R2

Use the information in this chapter to install and configure Reporting Services 2008 R2. This chapter contains the following sections:

- **Requirements**
- **Microsoft Dynamics GP CRM requirements**
- **Configuring Web Server (IIS) role for Reporting Services 2008 R2**
- **Installing Reporting Services 2008 R2**
- **Configuring Reporting Services 2008 R2**
- **Starting Report Manager**
- **Starting Report Server**
- **Creating a Reports site in Microsoft SharePoint 2010**
- **Creating a Reports Library in Microsoft SharePoint 2010**
- **Installing SQL Server Reporting Services Add-in for SharePoint 2010 Technologies**
- **Configuring Reporting Services Integration**

**Requirements**

The following components must be installed before you can install SQL Server Reporting Services 2008 R2 to use with Microsoft Dynamics GP.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td><strong>Server</strong></td>
</tr>
<tr>
<td>32-bit and 64-bit supported</td>
<td>Windows Server 2008 with latest service pack</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 R2 with latest service pack</td>
</tr>
<tr>
<td></td>
<td><strong>Client</strong></td>
</tr>
<tr>
<td></td>
<td>Windows 7 with latest service pack</td>
</tr>
<tr>
<td>Database</td>
<td>Microsoft SQL Server 2008 with service pack 1 or later</td>
</tr>
<tr>
<td></td>
<td>Microsoft SQL Server 2008 R2</td>
</tr>
<tr>
<td>SharePoint</td>
<td>Microsoft SharePoint Foundation 2010</td>
</tr>
<tr>
<td></td>
<td>Microsoft SharePoint Server 2010</td>
</tr>
<tr>
<td>Web browser</td>
<td>Internet Explorer 9</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 8</td>
</tr>
<tr>
<td>Microsoft Dynamics GP</td>
<td>Microsoft Dynamics GP 2013</td>
</tr>
</tbody>
</table>

**Microsoft Dynamics GP CRM requirements**

You must be using SQL Server 2008 R2 Reporting Services and Microsoft Dynamics CRM 2011 or later to deploy SQL Server Reporting Services reports and metrics that includes CRM data. Microsoft Dynamics CRM supports only the native mode of deployment of SQL Server Reporting Services.

You must install the Microsoft Dynamics CRM Reporting Extensions on the Microsoft Dynamics GP report server to render reports. Before you render a SQL Server Reporting Services report with CRM data, be sure to start the Microsoft Dynamics CRM application to initialize data.

**Configuring Web Server (IIS) role for Reporting Services 2008 R2**

Internet Information Services (IIS) must be installed before Reporting Services because a Web site and a Web services are created during the Reporting Services
installation. IIS is a set of Internet-based services for servers using Microsoft Windows. IIS hosts Web sites and Web services.

**To configure Web Server (IIS) for Windows Server 2008:**

1. Open the Server Manager.  
   (Start > Administrative Tools > Server Manager)

2. Select the **Roles** node in the Server Manager. The currently installed roles are displayed.

3. In the **Action** menu, choose **Add Roles**. The Add Roles Wizard appears. Click **Next** to continue.

4. In the list of available roles, select the **Web Server (IIS)** role.

5. In the message dialog, click **Add Required Features** to add features required for the Web Server (IIS) role.

6. Click **Next** to continue.

7. Review the information about the Web Server (IIS) role. Click **Next** to continue.

8. In the Select Role Services window, select the following subcomponents for the Web Server role service.

<table>
<thead>
<tr>
<th>Role Service component</th>
<th>Required subcomponent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common HTTP Features</td>
<td>Static Content</td>
</tr>
<tr>
<td></td>
<td>Default Document</td>
</tr>
<tr>
<td></td>
<td>Directory Browsing</td>
</tr>
<tr>
<td></td>
<td>HTTP Errors</td>
</tr>
<tr>
<td></td>
<td>HTTP Redirection</td>
</tr>
<tr>
<td>Application Development</td>
<td>ASP.Net</td>
</tr>
<tr>
<td></td>
<td>.NET Extensibility</td>
</tr>
<tr>
<td></td>
<td>ISAPI Extensions</td>
</tr>
<tr>
<td></td>
<td>ISAPI Filters</td>
</tr>
<tr>
<td></td>
<td>Server Side includes</td>
</tr>
<tr>
<td>Health and Diagnostics</td>
<td>HTTP Logging</td>
</tr>
<tr>
<td></td>
<td>Request Monitor</td>
</tr>
<tr>
<td>Security</td>
<td>Basic Authorization</td>
</tr>
<tr>
<td></td>
<td>Windows Authorization</td>
</tr>
<tr>
<td></td>
<td>Digest Authorization</td>
</tr>
<tr>
<td></td>
<td>Request Filtering</td>
</tr>
<tr>
<td>Performance</td>
<td>Static Content Compression</td>
</tr>
<tr>
<td></td>
<td>IIS Management Console</td>
</tr>
<tr>
<td></td>
<td>IIS 6 Management Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Metabase Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 WMI Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Scripting Tools</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Management Console</td>
</tr>
</tbody>
</table>

9. Click **Next**.

10. Review the installation messages, and then click **Install**.

11. After you have viewed the installation results, click **Close**.
12. Select the Features node in the Server Manager. The currently installed roles are displayed.

**To configure Web Server (IIS) for Windows Server 2008 R2:**

1. Open the Server Manager.  
   (Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click Next to continue.

4. In the list of available roles, select the Web Server (IIS) role.

5. In the message dialog, click Add Required Features to add features required for the Web Server (IIS) role.

6. Click Next to continue.

7. Review the information about the Web Server (IIS) role. Click Next to continue.

8. In the Select Role Services window, select the following subcomponents for the Web Server role service.

<table>
<thead>
<tr>
<th>Role Service component</th>
<th>Required subcomponent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common HTTP Features</td>
<td>Static Content</td>
</tr>
<tr>
<td></td>
<td>Default Document</td>
</tr>
<tr>
<td></td>
<td>Directory Browsing</td>
</tr>
<tr>
<td></td>
<td>HTTP Errors</td>
</tr>
<tr>
<td></td>
<td>HTTP Redirection</td>
</tr>
<tr>
<td>Application Development</td>
<td>ASP.Net</td>
</tr>
<tr>
<td></td>
<td>.NET Extensibility</td>
</tr>
<tr>
<td></td>
<td>ISAPI Extensions</td>
</tr>
<tr>
<td></td>
<td>ISAPI Filters</td>
</tr>
<tr>
<td></td>
<td>Server Side includes</td>
</tr>
<tr>
<td>Health and Diagnostics</td>
<td>HTTP Logging</td>
</tr>
<tr>
<td></td>
<td>Request Monitor</td>
</tr>
<tr>
<td>Security</td>
<td>Basic Authorization</td>
</tr>
<tr>
<td></td>
<td>Windows Authorization</td>
</tr>
<tr>
<td></td>
<td>Digest Authorization</td>
</tr>
<tr>
<td></td>
<td>Request Filtering</td>
</tr>
<tr>
<td>Performance</td>
<td>Static Content Compression</td>
</tr>
<tr>
<td>Management Tools</td>
<td>IIS Management Console</td>
</tr>
<tr>
<td></td>
<td>IIS 6 Management Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Metabase Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 WMI Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Scripting Tools</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Management Console</td>
</tr>
</tbody>
</table>

9. Click Next.

10. Review the installation messages, and then click Install.
11. After you have viewed the installation results, click Close.

12. Select the Features node in the Server Manager. The currently installed roles are displayed.

Installing Reporting Services 2008 R2

You can follow the instructions in this section if you have not yet installed Microsoft SQL Server Reporting Services. This procedure assumes that you have already installed Microsoft SQL Server 2008 R2, but not Reporting Services. These instructions are for installing Reporting Services as a single-server configuration. A single-server configuration is where the report server database is installed locally so that all server components are on the same computer. For more information about configurations, see Chapter 1, “Deployment configurations.”

When running the SQL Server installation program, you must be logged in as a member of the local system administrators group. Your SQL Server login account must have administrator permissions in SQL Server so you can create logins, roles and databases, and assign roles to logins.

To install Reporting Services 2008 R2:

1. Insert the SQL Server 2008 R2 media. The main SQL Server installation screen should appear. If you do not see this screen, browse the media and double-click the setup.exe file.

2. Click Yes to make changes to your computer if you are using User Account Control.

3. In the SQL Server Installation Center, click Installation.

4. Click New installation or add features to an existing installation.

5. In the Setup Support Rules window, click OK.

6. In the Setup Support Files window, click Install.

7. Your computer is scanned for conditions that may cause possible installation problems. To proceed with the installation, click Next.

8. In the Installation Type window, select Add features to an existing instance of SQL Server 2008 R2 and click Next.

9. In the Feature Selection window, select Reporting Services and any other feature you want to install. Click Next.

10. In the Installation Rules window, click Next.

11. In the Disk Space Requirements window, click Next.

12. In the Server Configuration window, enter the Account Name. Click Next.
13. In the Reporting Services Configuration window, click Next.

   You will have to configure the report server using the Reporting Services
   Configuration Manager after installing Reporting Services.

14. In the Error Reporting window, click Next.

15. In the Installation Configuration Rules window, click Next.

16. In the Ready to Install window, click Install.

17. The Installation Progress window appears, allowing you to view the status of
   the installation. Click Next after the installation is completed.

18. In the Complete window, click Close to exit the installation wizard.

19. Restart the computer if you are instructed to do so.

**Configuring Reporting Services 2008 R2**

After installing Reporting Services, use the Report Server Configuration Manager to
configure and start Reporting Services. The Report Server Configuration Manager
has a number of pages that you can use to configure Reporting Services.

**To configure Reporting Services 2008 R2:**

1. Start Reporting Services Configuration Manager.
   
   (Start > All Programs > Microsoft SQL Server 2008 R2 > Configuration Tools
   > Reporting Services Configuration Manager)

2. Click Yes to make changes to your computer if you are using User Account
   Control.

3. Enter the name of a server and select an instance to connect to a report server
   instance. Click Connect.

   If you installed Reporting Services on a Web server where SQL Server isn’t installed,
   connect to the reporting server and not the SQL server.

4. If Reporting Services isn’t running, click the Start button in the Report Server
   Status page. The Report Server Status page displays status information about
   the instance that you’ve selected.

5. In the navigation pane, click Service Account to open the page. Be sure that the
   Use the built-in account option is selected.

6. In the navigation pane, click Web Service URL to open the Web Service URL
   page. This page allows you to view and change the name of the virtual
   directory used by the Reporting Services Web service.

7. Click Apply to create a new virtual directory.

8. In the navigation pane, click Database to open the Report Server Database
   page.

9. Click Change Database.
10. Select to create a new report server database, and click Next.

11. Select Authentication type and specify the user name and password, if necessary. Click Next.

12. Specify the database name and specify the mode. Click Next.

13. Select Authentication type and specify the user name and password for your credentials, if necessary. Click Next.

14. Verify the database information. Click Next.

15. After the database is configured, click Finish.

16. If you selected Native mode for your report server database, click Report Manager URL to open the Report Manager URL page in the navigation pane. Click Apply.

17. Click Exit.

**Starting Report Manager**

Report Manager is installed during setup on the same computer as the report server. If you selected Native mode for your report server database, you should verify that you can connect to the Report Manager.

**To start Report Manager:**
1. Open Microsoft Internet Explorer.

2. In the address bar of the Web browser, type the Report Manager URL. By default, the URL is http://<ComputerName>/Reports.

**Starting Report Server**

If you selected the SharePoint Integrated mode for your report server database, you should verify that you can connect to the Report Server.

**To start Report Server:**
1. Open Microsoft Internet Explorer.

2. In the address bar of the Web browser, type the Report Manager URL. By default, the URL is http://<ComputerName>/ReportServer.

**Creating a Reports site in Microsoft SharePoint 2010**

If you selected the SharePoint Integrated mode for your report server database, you can store reports in a Microsoft SharePoint 2010 reports library. If you don’t have a site in Microsoft SharePoint that serves as a central location to manage Reporting Services reports, create a Reports site.

**To create a Reports site in Microsoft SharePoint 2010**
1. Type http://<ServerName> in the address field of Internet Explorer.

2. Click the Site Actions, and then click New site.
3. In the New SharePoint Site page, enter a title and description of the site.

4. Enter the URL name. For example, http://<ServerName>/Reports.

5. Select a template.

6. Choose any other option you want, and then click Create.

**Creating a Reports Library in Microsoft SharePoint 2010**

After creating a Reports site in Microsoft SharePoint, you need to create a reports library. A reports library is a location on the Reports site where you can store your Reporting Services reports.

**To create a Reports Library in Microsoft SharePoint 2010**

1. Type http://<ServerName>/Reports in the address field of Internet Explorer.

2. Click the Site Actions menu, and then click New Document Library.

3. In the New page, enter a name and a description.

4. Choose any other option you want, and then click Create.

5. In the Library Tools group, click Library settings.


7. In the Advanced settings page, select to allow management of content type.

8. Select Open in the client application as the default open behavior for browser-enabled documents.

9. Click OK.


11. Under Settings in Document page, click Name and description.

12. In the Settings page, change the name to Reports.

13. Click OK.

**Installing SQL Server Reporting Services Add-in for SharePoint 2010 Technologies**

The SQL Server 2008 R2 Reporting Services Add-in for Microsoft SharePoint Technologies 2010 allows you to integrate your reporting environment with Microsoft SharePoint. Once you install the add-in and configure your servers for integration, you can publish Reporting Services reports to a reports library and then view and manage the reports from a SharePoint site.
Installing the SQL Server 2008 R2 Reporting Services Add-in will activate the report server integration feature for all existing site collections and will automatically active for new site collections.

The SQL Server Reporting Services SharePoint 2010 Add-in is installed as a prerequisite for SharePoint Foundation and SharePoint Server if Reporting Services is already installed. If you install Reporting Services 2008 R2 after installing SharePoint, you can use the Microsoft SharePoint 2010 Products Preparation Tool to install the add-in or you can download the add-in from http://www.microsoft.com/downloads.

**To install the SQL Server Reporting Services Add-in for SharePoint 2010 Technologies:**


2. In the welcome window, click Next.

3. Accept the license agreement.

4. Enter registration information and click Next.

5. Click Install.

6. After the add-in is installed, click Finish.

**Configuring Reporting Services Integration**

You must specify integration settings that determine the connection between SharePoint and a report server. The settings that you specify are stored in the configuration database. You must be an administrator on the SharePoint farm to configure report server integration. You also must have a target report server that is already connected to a report server database that was created for SharePoint integrated.

If you don’t have the SQL Server Reporting Services SharePoint 2010 Add-in installed, the configuration pages and general integration are not available.

**To configure Reporting Services Integration**

1. Open SharePoint Central Administration. (Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central Administration)

2. Click General Application Settings.

3. Under the Reporting Services heading, click Reporting Services Integration.


5. Select Windows Authentication as the authentication mode.

6. Enter your credentials and click OK.
Chapter 5: Installing Reporting Services 2012

Use the information in this chapter to install and configure Reporting Services 2012. This chapter contains the following sections:

- **Requirements**
- **Microsoft Dynamics GP CRM requirements**
- **Configuring Web Server (IIS) role for Reporting Services 2012**
- **Installing Reporting Services 2012**
- **Configuring Reporting Services 2012 in Native mode**
- **Starting Report Manager**
- **Installing the Reporting Services SharePoint service**
- **Starting the Reporting Services SharePoint service**
- **Creating a Reporting Services service application**
- **Creating a Reports site in Microsoft SharePoint 2010**
- **Creating a Reports Library in Microsoft SharePoint 2010**
- **Configuring Reporting Services Integration**
- **Activating the Claims to Windows Token Service**

**Requirements**

The following components must be installed before you can install SQL Server Reporting Services 2012 to use with Microsoft Dynamics GP.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Operating system      | **Server**
                        | 32-bit and 64-bit supported                       |
|                       | Windows Server 2008 with latest service pack       |
|                       | Windows Server 2008 R2 with latest service pack    |
|                       | Windows Server 2012 (native mode only)            |
|                       | **Client**
                        | Windows 7 with latest service pack                 |
| Database               | **Server**
                        | Microsoft SQL Server 2008 with service pack 1 or later |
|                       | Microsoft SQL Server 2008 R2                      |
|                       | Microsoft SQL Server 2012                         |
| SharePoint             | **Server**
                        | Microsoft SharePoint Foundation 2010 with service pack 1 |
|                       | Microsoft SharePoint Server 2010 with service pack 1 |
| Web browser            | **Server**
                        | Internet Explorer 9                               |
|                       | Microsoft Dynamics GP 2013                         |
| Microsoft Dynamics GP  | **Server**
                        | Internet Explorer 8                               |

**Microsoft Dynamics GP CRM requirements**

You must be using SQL Server 2012 Reporting Services and Microsoft Dynamics CRM 2011 or later to deploy SQL Server Reporting Services reports and metrics that includes CRM data. Microsoft Dynamics CRM supports only the native mode of deployment of SQL Server Reporting Services.

You must install the Microsoft Dynamics CRM Reporting Extensions on the Microsoft Dynamics GP report server to render reports. Before you render a SQL Server Reporting Services report with CRM data, be sure to start the Microsoft Dynamics CRM application to initialize data.
Configuring Web Server (IIS) role for Reporting Services 2012

Internet Information Services (IIS) must be installed before Reporting Services because a Web site and a Web services are created during the Reporting Services installation. IIS is a set of Internet-based services for servers using Microsoft Windows. IIS hosts Web sites and Web services.

To configure Web Server (IIS) for Windows Server 2008:

1. Open the Server Manager. 
   (Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click Next to continue.

4. In the list of available roles, select the Web Server (IIS) role.

5. In the message dialog, click Add Required Features to add features required for the Web Server (IIS) role.

6. Click Next to continue.

7. Review the information about the Web Server (IIS) role. Click Next to continue.

8. In the Select Role Services window, select the following subcomponents for the Web Server role service.

<table>
<thead>
<tr>
<th>Role Service component</th>
<th>Required subcomponent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common HTTP Features</td>
<td>Static Content</td>
</tr>
<tr>
<td></td>
<td>Default Document</td>
</tr>
<tr>
<td></td>
<td>Directory Browsing</td>
</tr>
<tr>
<td></td>
<td>HTTP Errors</td>
</tr>
<tr>
<td></td>
<td>HTTP Redirection</td>
</tr>
<tr>
<td>Application Development</td>
<td>ASP .Net</td>
</tr>
<tr>
<td></td>
<td>.NET Extensibility</td>
</tr>
<tr>
<td></td>
<td>ISAPI Extensions</td>
</tr>
<tr>
<td></td>
<td>ISAPI Filters</td>
</tr>
<tr>
<td></td>
<td>Server Side includes</td>
</tr>
<tr>
<td>Health and Diagnostics</td>
<td>HTTP Logging</td>
</tr>
<tr>
<td></td>
<td>Request Monitor</td>
</tr>
<tr>
<td>Security</td>
<td>Basic Authorization</td>
</tr>
<tr>
<td></td>
<td>Windows Authorization</td>
</tr>
<tr>
<td></td>
<td>Digest Authorization</td>
</tr>
<tr>
<td></td>
<td>Request Filtering</td>
</tr>
<tr>
<td>Performance</td>
<td>Static Content Compression</td>
</tr>
<tr>
<td></td>
<td>IIS Management Console</td>
</tr>
<tr>
<td></td>
<td>IIS 6 Management Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Metabase Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 WMI Compatibility</td>
</tr>
<tr>
<td></td>
<td>ISS 6 Scripting Tools</td>
</tr>
</tbody>
</table>

9. Click Next.
10. Review the installation messages, and then click **Install**.

11. After you have viewed the installation results, click **Close**.

12. Select the **Features** node in the Server Manager. The currently installed roles are displayed.

**To configure Web Server (IIS) for Windows Server 2008 R2:**

1. Open the Server Manager.
   
   \(\text{Start} \rightarrow \text{Administrative Tools} \rightarrow \text{Server Manager}\)

2. Select the **Roles** node in the Server Manager. The currently installed roles are displayed.

3. In the **Action** menu, choose **Add Roles**. The Add Roles Wizard appears. Click **Next** to continue.

4. In the list of available roles, select the **Web Server (IIS)** role.

5. In the message dialog, click **Add Required Features** to add features required for the Web Server (IIS) role.

6. Click **Next** to continue.

7. Review the information about the Web Server (IIS) role. Click **Next** to continue.

8. In the Select Role Services window, select the following subcomponents for the Web Server role service.

<table>
<thead>
<tr>
<th>Role Service component</th>
<th>Required subcomponent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common HTTP Features</td>
<td>Static Content, Default Document, Directory Browsing, HTTP Errors, HTTP Redirection</td>
</tr>
<tr>
<td>Application Development</td>
<td>ASP.Net, .NET Extensibility, ISAPI Extensions, ISAPI Filters, Server Side includes</td>
</tr>
<tr>
<td>Health and Diagnostics</td>
<td>HTTP Logging, Request Monitor</td>
</tr>
<tr>
<td>Performance</td>
<td>Static Content Compression</td>
</tr>
<tr>
<td>Management Tools</td>
<td>IIS Management Console, IIS 6 Management Compatibility, ISS 6 Metabase Compatibility, ISS 6 WMI Compatibility, ISS 6 Scripting Tools, ISS 6 Management Console</td>
</tr>
</tbody>
</table>
9. Click Next.

10. Review the installation messages, and then click Install.

11. After you have viewed the installation results, click Close.

12. Select the Features node in the Server Manager. The currently installed roles are displayed.

**To configure Web Server (IIS) for Windows Server 2012:**

1. Open the Server Manager.
   (On the Windows Start screen, click the Server Manager tile.)

2. Under Manage menu, select Add roles and features.

3. Select the Role-based or feature based installation option as the installation type and click Next.

4. Select the appropriate server to install the roles and features to and click Next.

5. Select Web Server (IIS) and click Next.

6. In the message dialog, click Add Required Features to add features required for the Web Server (IIS) role.

7. Click Next to continue.

8. Review the information about the Web Server (IIS) role. Click Next to continue.

9. In the Select Role Services window, be sure that the following subcomponents are selected for the Web Server role service.

<table>
<thead>
<tr>
<th>Role Service component</th>
<th>Required subcomponent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common HTTP Features</td>
<td>Static Content</td>
</tr>
<tr>
<td></td>
<td>Default Document</td>
</tr>
<tr>
<td></td>
<td>Directory Browsing</td>
</tr>
<tr>
<td></td>
<td>HTTP Errors</td>
</tr>
<tr>
<td></td>
<td>HTTP Redirection</td>
</tr>
<tr>
<td>Application Development</td>
<td>ASPNet 3.5</td>
</tr>
<tr>
<td></td>
<td>ASPNet 4.5</td>
</tr>
<tr>
<td></td>
<td>.NET Extensibility 3.5</td>
</tr>
<tr>
<td></td>
<td>.NET Extensibility 4.5</td>
</tr>
<tr>
<td></td>
<td>ISAPI Extensions</td>
</tr>
<tr>
<td></td>
<td>ISAPI Filters</td>
</tr>
<tr>
<td></td>
<td>Server Side includes</td>
</tr>
<tr>
<td>Health and Diagnostics</td>
<td>HTTP Logging</td>
</tr>
<tr>
<td></td>
<td>Request Monitor</td>
</tr>
<tr>
<td>Security</td>
<td>Basic Authorization</td>
</tr>
<tr>
<td></td>
<td>Windows Authorization</td>
</tr>
<tr>
<td></td>
<td>Digest Authorization</td>
</tr>
<tr>
<td></td>
<td>Request Filtering</td>
</tr>
<tr>
<td>Performance</td>
<td>Static Content Compression</td>
</tr>
</tbody>
</table>
10. Click **Install**.

11. After you have viewed the installation results, click **Close**.

### Installing Reporting Services 2012

You can follow the instructions in this section if you have not yet installed Microsoft SQL Server Reporting Services. This procedure assumes that you have already installed Microsoft SQL Server 2012, but not Reporting Services. These instructions are for installing Reporting Services as a single-server configuration. A single-server configuration is where the report server database is installed locally so that all server components are on the same computer. For more information about configurations, see Chapter 1, “Deployment configurations.”

When running the SQL Server installation program, you must be logged in as a member of the local system administrators group. Your SQL Server login account must have administrator permissions in SQL Server so you can create logins, roles and databases, and assign roles to logins.

> The SQL Server that hosts your Microsoft Dynamics GP data must be using mixed-mode authentication. (Mixed-mode authentication allows you to use either Windows Authentication or SQL Authentication to access the SQL Server.)

#### To install Reporting Services 2012:

1. Insert the SQL Server 2012 media. The main SQL Server installation screen should appear. If you do not see this screen, browse the media and double-click the setup.exe file.

2. Click **Yes** to make changes to your computer if you are using User Account Control.

3. In the SQL Server Installation Center, click **Installation**.

4. Click **New SQL Server stand-alone installation or add features to an existing installation**.

5. In the Setup Support Rules window, click **OK**.

6. In the Product Updates window, click **Next**.

7. Your computer is scanned for conditions that may cause possible installation problems. To proceed with the installation, click **Next**.

8. In the Installation Type window, select **Add features to an existing instance of SQL Server 2012** and click **Next**.
9. In the Feature Selection window, select Reporting Services – Native or Reporting Services – SharePoint and any other feature you want to install. Click Next.

Be sure to select Reporting Services Add-in for SharePoint Products if you are installing on the server where SharePoint is running.

10. In the Installation Rules window, click Next.

11. In the Disk Space Requirements window, click Next.

12. In the Server Configuration window, specify the service account for SQL Server Reporting Services and click Next.

13. In the Reporting Services Configuration window, click Next.

If you are using Native mode, you will have to configure the report server using the Reporting Services Configuration Manager after installing Reporting Services.

If you are using SharePoint Integrated mode, you will have to use the SharePoint Central Administration to complete the configuration. You’ll also verify the SQL Server Reporting Services service is started and create at least one SQL Server Reporting Services service application.

14. In the Error Reporting window, click Next.

15. In the Installation Configuration Rules window, click Next.

16. In the Ready to Install window, click Install.

17. The Installation Progress window appears, allowing you to view the status of the installation. Click Next after the installation is completed.

18. In the Complete window, click Close to exit the installation wizard.

19. Restart the computer if you are instructed to do so.

**Configuring Reporting Services 2012 in Native mode**

After installing Reporting Services, use the Report Server Configuration Manager to configure and start Reporting Services. The Report Server Configuration Manager has a number of pages that you can use to configure Reporting Services.

**To configure Reporting Services 2012 in Native mode:**

1. Start Reporting Services Configuration Manager. 
   (Start > All Programs > Microsoft SQL Server 2012 > Configuration Tools > Reporting Services Configuration Manager)

2. Click Yes to make changes to your computer if you are using User Account Control.

3. Enter the name of a server and select an instance to connect to a report server instance. Click Connect.
If you installed Reporting Services on a Web server where SQL Server isn’t installed, connect to the reporting server and not the SQL server.

4. If Reporting Services isn’t running, click the Start button in the Report Server Status page. The Report Server Status page displays status information about the instance that you’ve selected.

5. In the navigation pane, click Service Account to open the page. Be sure that the Use the built-in account option is selected.

6. In the navigation pane, click Web Service URL to open the Web Service URL page. This page allows you to view and change the name of the virtual directory used by the Reporting Services Web service.

7. Click Apply to create a new virtual directory.

8. In the navigation pane, click Database to open the Report Server Database page.

9. Click Change Database.

10. Select to create a new report server database, and click Next.

11. Select Authentication type and specify the user name and password, if necessary. Click Next.

12. Specify the database name and specify the mode. Click Next.

13. Select Authentication type and specify the user name and password for your credentials, if necessary. Click Next.

14. Verify the database information. Click Next.

15. After the database is configured, click Finish.

16. Click Report Manager URL to open the Report Manager URL page in the navigation pane. Click Apply.

17. Click Exit.

Starting Report Manager

Report Manager is installed during setup on the same computer as the report server. If you selected Native mode for your report server database, you should verify that you can connect to the Report Manager.

To start Report Manager:
1. Open Microsoft Internet Explorer.

2. In the address bar of the Web browser, type the Report Manager URL. By default, the URL is http://<ComputerName>/Reports.
Installing the Reporting Services SharePoint service

The SharePoint Integrated mode for Reporting Services uses a SharePoint service. If the SharePoint farm is new, the necessary files were installed as part of the Reporting Services using the SQL Server installation wizard. You still need register service into the SharePoint farm.

You don’t need to complete the following steps for an existing SharePoint farm. The Reporting Services SharePoint service was installed and started when you used the SQL Server installation wizard to install Reporting Services.

To install the Reporting Services SharePoint service:
1. Open the Windows PowerShell®.
   Start > Microsoft SharePoint 2010 Products > right-click SharePoint 2010 Management Shell > click Run as administrator
2. Run the following command to install the SharePoint service.
   Install-SPRSService
   If the command was successful, a new line appears in the management shell.
3. Run the following command to install the service proxy.
   Install-SPRSServiceProxy

Starting the Reporting Services SharePoint service

After installing the Reporting Services SharePoint service, you must start or verify that the service is running.

To start Reporting Services SharePoint service:
1. Open SharePoint Central Administration.
   Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central Administration
2. Under the System Settings heading, click Manage services on server.
3. Be sure that the SQL Server Reporting Services Service is started. If the service isn’t started, click Start in the Action column.
   If the SQL Server Reporting Services Service is not in the list, verify you have installed the service. See Installing the Reporting Services SharePoint service on page 38.

Creating a Reporting Services service application

The SharePoint Integrated mode for Reporting Services uses a SharePoint service and one or more service applications. Creating a service application makes the service available and generates the service application database. One service application is sufficient for most deployment configurations, but you can create multiple Reporting Services service applications.
To create Reporting Services service application:

1. Open SharePoint Central Administration.
   Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central Administration

2. Under the Application Management heading, click Manage service applications.

3. In the SharePoint ribbon, click New.

4. In the New menu, select SQL Server Reporting Services Service Application.
   
   If the SQL Server Reporting Services Service Application is not in the list, verify you have installed the service. See Installing the Reporting Services SharePoint service.

5. In the Create SQL Server Reporting Services Service Application page, enter a name for the application.

6. In Application Pool section, create a new application pool for the application.

7. Select or create a managed account for the application pool. Be sure to specify a domain user account.
   
   A domain user account allows you to use SharePoint's managed account feature, which allows you to update passwords and account information in one place.

8. In the Database server field, accept the current server or enter a different SQL Server.

9. In Database Name field, the default value is ReportingService_<guid>, which is a unique database name. If you enter a new value, we recommend that you use a unique database for each service application.

10. In Database Authentication option, the default value is Windows Authentication. If you choose SQL Authentication, refer to the SharePoint administrator guide for best practices about this authentication type in a SharePoint deployment.

11. In the Web Application Association section, select the web application to be used for access by the current Reporting Services Service Application. You can associate one Reporting Services service application to one web application.

12. Click OK.
   
   The service application creation process may take several minutes to complete.

Creating a Reports site in Microsoft SharePoint 2010

If you selected the SharePoint Integrated mode for your report server database, you can store reports in a Microsoft SharePoint 2010 reports library. If you don't have a site in Microsoft SharePoint that serves as a central location to manage Reporting Services reports, create a Reports site.
**To create a Reports site in Microsoft SharePoint 2010**
1. Type http://<ServerName> in the address field of Internet Explorer.
2. Click the Site Actions, and then click New site.
3. In the New SharePoint Site page, enter a title and description of the site.
4. Enter the URL name. For example, http://<ServerName>/Reports.
5. Select a template.
6. Choose any other option you want, and then click Create.

**Creating a Reports Library in Microsoft SharePoint 2010**

After creating a Reports site in Microsoft SharePoint, you need to create a reports library. A reports library is a location on the Reports site where you can store your Reporting Services reports.

**To create a Reports Library in Microsoft SharePoint 2010**
1. Type http://<ServerName>/Reports in the address field of Internet Explorer.
2. Click the Site Actions menu, and then click New Document Library.
3. In the New page, enter a name and a description.
4. Choose any other option you want, and then click Create.
5. In the Library Tools group, click Library settings.
7. In the Advanced settings page, select to allow management of content type.
8. Select Open in the client application as the default open behavior for browser-enabled documents.
9. Click OK.
11. Under Settings in Document page, click Name and description.
12. In the Settings page, change the name to Reports.
13. Click OK.
Configuring Reporting Services Integration

You must specify integration settings that determine the connection between SharePoint and a report server. The settings that you specify are stored in the configuration database. You must be an administrator on the SharePoint farm to configure report server integration. You also must have a target report server that is already connected to a report server database that was created for SharePoint integrated.

If you don’t have the SQL Server Reporting Services SharePoint 2010 Add-in installed, the configuration pages and general integration are not available.

To configure Reporting Services Integration:
1. Open SharePoint Central Administration.
   (Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central Administration)
2. Click General Application Settings.
3. Under the Reporting Services heading, click Reporting Services Integration.
5. Select Windows Authentication as the authentication mode.
6. Enter your credentials and click OK.

Activating the Claims to Windows Token Service

Be sure that the Claims to Windows Token Service has been started.

To activate the Claims to Windows Token Service:
1. Open SharePoint Central Administration.
   (Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central Administration)
2. Under the System Settings heading, click Manage services on server.
3. Be sure that the Claims to Windows Token Service is started. If the service isn’t started, click Start in the Action column.
Chapter 6: Deploying Reporting Services reports

This chapter explains how to deploy predefined SQL Server Reporting Services reports that are included in Microsoft Dynamics GP to a server or Microsoft SharePoint site. You also can deploy charts and key performance indicators (KPIs). Once the reports and charts and KPIs are stored on a server or on a Microsoft SharePoint library, users can access them without starting Microsoft Dynamics GP as long as they have the appropriate security access.

Before you deploy Reporting Services reports, be sure that Dexterity Shared Components are installed on the computer.

This chapter includes the following sections.

- Modify the Report Server web.config file
- Using the Reporting Tools Setup window
- Deploying SQL Server Reporting Services reports in Native mode
- Deploying SQL Server Reporting Services reports in SharePoint Integrated mode

Modify the Report Server web.config file

To deploy the SQL Server Reporting Services reports, you must modify the Report Server web.config file for the timeout execution and the maximum request length. If you don’t update the Report Server web.config file for the timeout execution, you might receive an error that states that “the operation has timed out.” If you don’t update the Report Server web.config file for the maximum request length, you will receive an error that the deployment has exceeded the maximum request length allowed by the target server.

You must be an administrator to modify the Report Server web.config file.

To modify the Report Server Web.config file:

1. Create a backup copy of the web.config file located in the ReportServer folder. (The ReportServer folder is located in C:\Program Files\Microsoft SQL Server\MSSQLSERVER\Reporting Services\ReportServer where Reporting Services is installed.)

2. Open the Report Server web.config file using a text editor, such as Notepad.

3. Search for <httpRuntime executionTimeout="9000" />

4. In that line, change executionTimeout="9000" to executionTimeout="19000" and add the value maxRequestLength="20960".

   (<httpRuntime executionTimeout="19000" maxRequestLength="20960"/>


Using the Reporting Tools Setup window

Use the Reporting Tools Setup window to deploy the predefined SQL Server Reporting Services reports that are available in Microsoft Dynamics GP to the Report Server or to a Microsoft SharePoint library. You also can use the Reporting Tools Setup window to redeploy reports or deploy reports to a different location.
Deploying reports to a new location does not deploy reports from the existing location to the new location. If you are using more than one instance of Microsoft Dynamics GP, you should only deploy reports to the report server for one instance at a time.

**Deployment Options**  The Deployment Options list has a tree view that displays the deployment status of each company and of each report type. You can select to deploy reports by company and by report type.

There are three levels in the tree view. You can collapse and expand the entire tree or just portions of it. A check mark next to a level means that the reports are available to deploy. All items that are not fully deployed will automatically be marked.

**Redeplace all reports for selected companies**  You can mark to redeploy reports for the companies you selected. When you choose the Deploy Reports button, previously deployed reports for the selected companies are overwritten.

**Print status of all companies**  You can mark this option to print the SQL Server Reporting Services Deployment Status report. The report displays information for all companies. You can choose File > Print to print the report with only information for the company you are currently logged in to.

**Refresh button**  Choose this button to validate and save the report location information. The Deployment Options tree view is updated based on the report location information.

**Deploying SQL Server Reporting Services reports in Native mode**

Use the Reporting Tools Setup window to deploy the predefined SQL Server Reporting Services reports that are available in Microsoft Dynamics GP to the Report Server. You also can use the Reporting Tools Setup window to redeploy reports or deploy reports to a different location. You also can deploy charts and KPIs. If you are using more than one instance of Microsoft Dynamics GP, you should only deploy reports to the report server for one instance at a time.

**To deploy SQL Server Reporting Services reports in Native mode:**

1. Open the Reporting Tools Setup window.
   (Administration > Setup > System > Reporting Tools Setup)
2. On the SQL Reporting Services tab, select the Native mode.

3. Enter the following locations for the Native mode. Be sure that your location doesn’t end with a slash.

   **Native mode location example:**

<table>
<thead>
<tr>
<th>Location</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Manager URL</td>
<td>http://&lt;servername&gt;/Reports</td>
</tr>
</tbody>
</table>

4. You can enter the name of the folder to deploy the reports to. By using a folder, you can deploy Reporting Services reports for multiple Microsoft Dynamics GP instances to a single Microsoft SQL Server Reporting Server. The default folder name is the name of the system database. If DYNAMICS is the system database name, the Folder Name field is blank. After deploying reports to the folder, you must provide access to the folder.

5. If you are using Microsoft Dynamics CRM 2011 or later, enter the URL for the CRM service, the name of the organization, and specify credentials for the data source.

   We recommend that you use Windows Authentication (Integrated Security). If you select to be prompted for credentials, you must mark the Use as Windows credentials when connecting to the data source option on the data source deployed.
You must be using SQL Server 2008 R2 Reporting Services or SQL Server 2012 Reporting Services and Microsoft Dynamics CRM 2011 or later to deploy SQL Server Reporting Services reports and metrics that includes CRM data. Microsoft Dynamics CRM supports only the native mode of deployment of SQL Server Reporting Services.

6. To verify your locations, choose the **Refresh** button in the upper right hand corner of the Deployment Options tree view.

7. In the Deployment Options tree view, all items that are not fully deployed are automatically marked.

   To exclude an item, unmark the check box. For example, if you don’t want to deploy Reporting Services reports in Fabrikam, Inc., expand the Company level in the tree view and unmark SRS Reports.

8. Choose **Deploy Reports** to deploy reports.

   The Business Intelligence Deployment Progress window appears. This window displays the report deployment progress.

   ![Business Intelligence Deployment Progress](image)

   If you don’t have the appropriate permissions to deploy reports, a window opens where you can enter a domain\user name and the password you use to log in to Microsoft Windows.

9. After the reports are deployed, choose **Print Status Report** to view the deployment status of reports.

**Deploying SQL Server Reporting Services reports in SharePoint Integrated mode**

Use the Reporting Tools Setup window to deploy the predefined SQL Server Reporting Services reports that are available in Microsoft Dynamics GP to a Microsoft SharePoint library. You also can use the Reporting Tools Setup window to redeploy reports or deploy reports to a different location. You also can deploy charts and KPIs. If you are using more than one instance of Microsoft Dynamics GP, you should only deploy reports to the report server for one instance at a time.

**To deploy SQL Server Reporting Services reports in SharePoint Integrated mode:**

1. Open the Reporting Tools Setup window.
   (Administration > Setup > System > Reporting Tools Setup)
2. On the **SQL Reporting Services** tab, select the **SharePoint Integrated** mode.

![SQL Reporting Services tab](image.png)

3. Enter the locations for the SharePoint site and report library. Be sure that your location doesn’t end with a slash.

SharePoint Integrated mode location example:

<table>
<thead>
<tr>
<th>Location</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>SharePoint Site</td>
<td>http://&lt;servername&gt;/SharePoint site</td>
</tr>
<tr>
<td>Report Library</td>
<td>ReportsLibrary</td>
</tr>
</tbody>
</table>

Microsoft Dynamics CRM 2011 or later supports only the native mode of deployment of Microsoft SQL Server Reporting Services.

4. To verify your locations, choose the **Refresh** button in the upper right hand corner of the Deployment Options tree view.

5. In the Deployment Options tree view, all items that are not fully deployed are automatically marked.

To exclude an item, unmark the check box. For example, if you don’t want to deploy Reporting Services reports in Fabrikam, Inc., expand the Company level in the tree view and unmark SRS Reports.

6. Choose **Deploy Reports** to deploy reports.
The Business Intelligence Deployment Progress window appears. This window displays the report deployment progress.

If you don’t have the appropriate permissions to deploy reports, a window opens where you can enter a domain\user name and the password you use to log in to Microsoft Windows.

7. After the reports are deployed, choose Print Status Report to view the deployment status of reports.
Chapter 7: Reporting Services Security Setup

After the installation and configuration of Reporting Services and deploying the Microsoft Dynamics GP SQL Server Reporting Services reports, the only individuals who will be able to access or view the reports within the Report Manager are those users who are members of the Web server’s local administrator group and local administrators on SQL Server. The Web site administrator has to implement and grant access to the Reporting Services Web site and database objects required to print reports.

If you deployed reports to Microsoft SharePoint, you can use Microsoft SharePoint security to grant access to report server items that you access from SharePoint sites and libraries. SharePoint security is similar to how role assignments are used in a native mode report server deployment, where a role assignment maps a user or group account to a set of tasks related to an item.

This chapter has the following sections.

- Designing Reporting Services security
- Granting access to the Reporting Services Web site
- Database security setup
- SharePoint Security for Reporting Services
- Creating a permission level in SharePoint 2010
- Creating a new group in SharePoint 2010
- Granting a group access to a site in SharePoint 2010
- Adding users to a group in SharePoint 2010

Designing Reporting Services security

Before you implementing security for Reporting Services, determine your security requirements. You should identify the following information.

- Which users have access to which companies
- Which users should have access to which series of reports
- Which users should or should not have access to an individual report

The default security setup is to use your Windows credentials through to the database level. The process is the same as granting access to files and folders at the Windows level. You’ll use groups or individual domain users when granting access. For the domain users or groups to have access and see the reports within the Report Manager, they must be granted permission at the Web site.

Granting access to the Reporting Services Web site

To get the domain users to view and have access the reports within the Report Manager, they must be granted permission to the Web site using SQL Server Management Studio or the Report Manager.

To grant access from the Report Manager using Reporting Services 2008:

1. Open Report Manager by entering the Report Manager URL in the address bar of the Web browser. The default URL is http://<ComputerName>/reports.

2. Click Site Settings on the home page.
CHAPTER 7  REPORTING SERVICES SECURITY SETUP

If Site Settings is not available, you do not have permission to access site settings.

3. In the Site Settings page, click Security.

4. To enable access for a new user or group, click New Role Assignment.

5. Enter the name of the user or group account.

6. Select one or more system role definitions to use with this assignment.

7. Click OK.

8. Click Home to open the Home page.

9. Click the Properties tab.

10. Click New Role Assignment to open the New Role Assignment page.

11. Enter the name of the user or group account.

12. Select select one or more roles until the combined set of tasks describe the actions that the user should be allowed to perform. To view the set of tasks that each role supports, click the role name.

To grant access from the Report Manager using Reporting Services 2008 R2 or 2012:

1. Open Report Manager by entering the Report Manager URL in the address bar of the Web browser. The default URL is http://<ComputerName>/reports.

2. Click Site Settings on the home page.

   If Site Settings is not available, you do not have permission to access site settings.

3. In the Site Settings page, click Security.

4. To enable access for a new user or group, click New Role Assignment.

5. Enter the name of the user or group account.

6. Select one or more system role definitions to use with this assignment.

7. Click OK.

8. Click Home to open the Home page.

9. Click the Folder Settings tab.

10. Click New Role Assignment to open the New Role Assignment page.

11. Enter the name of the user or group account.

12. Select select one or more roles until the combined set of tasks describe the actions that the user should be allowed to perform.
Database security setup

You need to grant group or user access to SQL Server and the appropriate databases to allow a user to run Report Services reports. Use the following procedure to create a new SQL Server login for the group or user and assign the appropriate database roles to the login for access to Report Services reports. To review what database roles for reports are available, download MDGP11R2_SRS_Report_Roles.pdf (https://mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-f3dd5b30632b). (CustomerSource login required.)

Users might see reports listed in a browser, but they cannot view the data on the reports until security access has been granted in SQL Server.

Before creating new SQL Server logins, you should carefully plan the accounts and the type of accounts to be created. You need to decide whether or not to add the individual Windows accounts or to use local or domain groups for access. You should consider access to the Report Services reports and the local folders being created on the Web server, as well.

To add Windows domain users or groups in SQL Server:
1. Open SQL Server Management Studio. (Start > All Programs > Microsoft SQL Server > SQL Server Management Studio)
2. Select Database Engine, enter the name of server, and enter authentication information. Click Connect.
3. Expand the Security folder.
4. Right-click the Logins folder, and select New Login.
5. In the Login – New window, enter the user or group that you want to have access to the SQL Server. If you don’t know the login name, you can click the Search button and look for the name.
6. Click OK.
7. After adding the login, it should be listed under the Logins folder.
8. To add new login as a user to the appropriate database, right-click the new login, and click Properties.
10. Under Users mapped to this login, mark Dynamics.
11. Under Database role membership for: Dynamics, mark the rpt_All user database role or the rpt_All group database role.
   
   *The rpt_All group database role is required for all users to run Reporting Services reports.*

12. Under Users mapped to this login, mark the company database that the user or group should have access to.
13. Under Database role membership for: <company database>, mark the appropriate database roles that are required.

To review what database roles for reports, download To review what database roles for reports, download MDGP11R2_SRS_Report_Roles.pdf (https://mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-f3dd5b30632b). (CustomerSource login required.)

14. Click OK.

**SharePoint Security for Reporting Services**

You can use Microsoft SharePoint security to grant access to report server items that you access from SharePoint sites and libraries. SharePoint security is similar to how role assignments are used in a native mode report server deployment, where a role assignment maps a user or group account to a set of tasks related to an item. The policies of SharePoint security map a user or group account with a permission level.

SharePoint groups and permission levels are defined at the site collection level and are inherited from the parent object by default. A SharePoint group is a set of users that can be managed together. Permission levels are collections of permissions that allow users to perform a set of related tasks.

If you already assigned permissions to users, those same users will have access to report server items and operations immediately after you configure the integration settings between SharePoint and a report server. You can use existing permissions to upload report definitions and other documents, view reports, create subscriptions, and manage items.

If you have not assigned permissions, you can assign user and group accounts to predefined SharePoint groups or create new permission levels and groups, or modify existing ones to vary server access permissions as the need arise.

**Creating a permission level in SharePoint 2010**

Permission levels are used globally throughout a site. If you create a new permission level, it will be available to other site owners. You may want to create a permission level for users who aren’t administrators so they can view reports in the document library.

**To create a permission level in SharePoint 2010:**

1. Verify that you have one of the following administrative credentials:
   - You are a member of the Administrators group for the site collection.
   - You are a member of the Owners group for the site.
   - You have the Manage Permissions permission.

2. On the Site Settings page, under Users and Permissions, click Site permissions.

3. In the Manage section of the ribbon, click Permission Levels.

4. On the toolbar, click Add a Permission Level.

5. On the Add a Permission Level page, enter a name for the new permission level. For example, Read Reports.
6. Enter a description of the new permission level.

7. In the list of permissions, select the check boxes to add permissions to the permission level. Be sure to select the following permissions.

<table>
<thead>
<tr>
<th>Type</th>
<th>Permissions</th>
</tr>
</thead>
</table>
| List Permission| Edit Items
                  | View Items
                  | Open Items             |
| Site Permission| View Pages
                        | Browse User Information
                        | Use Remote Interfaces
                        | Open                   |

8. Click Create.

Creating a new group in SharePoint 2010

A SharePoint group is a set of users that can be managed together. You may want to create a group for users who aren’t administrators so they can view reports in the document library.

To create a group, you need to have the Manage Permissions level for the site or content you are working with. To see if you have Manage Permissions permissions level, click the Site Actions menu and look for the Site Permissions option. If you don’t have the option, you don’t have the permission to manage permissions.

To create a new group in SharePoint 2010:
1. On the Site Actions menu, click Site Permissions.
2. On the Permission Tools tab, click Create Group.
3. On the Create Group page, in the Name and About Me Description section, specify the name and optionally a description for this security group.
4. In the Owner section, specify the owner of this security group.
5. In the Group Settings section, specify who can view and edit the membership of this group.
6. In the Membership Requests section, specify the settings that you want for requests to join or leave the group.
7. Click Create.

Granting a group access to a site in SharePoint 2010

To grant a group access to a SharePoint, you need to have the Manage Permissions level for the site or content you are working with. To see if you have Manage Permissions permissions level, click the Site Actions menu and look for the Site Permissions option. If you don’t have the option, you don’t have the permission to manage permissions.
To grant a group access to a site in SharePoint 2010:
1. On the Site Actions menu, click Site Permissions.
2. Click Grant Permissions.
3. In the Grant Permissions window, enter the names of the groups (or users) to whom you want to grant access to your site.
4. If you enter the names of users, you can add them to an existing group. (You can grant permissions to individual users directly. However, the cost of maintaining a system such as that adds up quickly.)
5. Click OK.

Adding users to a group in SharePoint 2010

To add users to a group, you need to have the Manage Permissions level for the site or content you are working with. To see if you have Manage Permissions permissions level, click the Site Actions menu and look for the Site Permissions option. If you don’t have the option, you don’t have the permission to manage permissions.

To add users to a group in SharePoint 2010:
1. On the Site Actions menu, click Site Permissions.
2. On the permissions page, click the link for the security group to which you want to add users.
3. On the People and Groups - Group Name page, on the New menu, click Add Users.
4. In the Grant Permissions window, use the browse button to select the users that you want to add to this security group.
Index

C
checklists
  Reporting Services 2008 installation for Native mode 9
  Reporting Services 2008 R2 installation for Microsoft SharePoint 2010 11
  Reporting Services 2008 R2 installation for Native mode 10
  Reporting Services 2012 installation for Microsoft SharePoint 2010 13
  Reporting Services 2012 installation for Native mode 12
Claims to Windows Token Service, activating for SharePoint 2010 41
configurations
diagrams 5
  Reporting Services 2008 19-20
  Reporting Services 2008 R2 27-28
  Reporting Services 2012 in Native mode 36-37
  Reporting Services 2012 in SharePoint Integrated mode 38-39
separate Web server 6
server farm 6
single server 5
standard deployment model 5
Web Server (IIS) role for Reporting Services 2008 15-17
Web Server (IIS) role for Reporting Services 2008 R2 23-26
Web Server (IIS) role for Reporting Services 2012 32-35

D
database security
group access to reports 51
user access to reports 51
deployment configurations
diagrams 5
  separate Web server 6
  server farm 6
  single server 5
  standard 5
diagrams
  separate Web server configuration 6
  server farm configuration 6
  single-server configuration 5
documentation, symbols and conventions 2

I
icons, used in manual 2
installation
  configuring Web Server (IIS) for Reporting Services 2008 15-17
  configuring Web Server (IIS) for Reporting Services 2008 R2 23-26

R
Report Manager
  access to reports 49
  connecting to
    Report Manager 2008 20
    Report Manager 2008 R2 28
    Report Manager 2012 37
  granting access to reports ??-50
Report Server
  connecting to
    Report Server 2008 20
    Report Server 2008 R2 28
    modify web.config file 43
Reporting Services
  deployment configurations 5
  designing security 49
Reporting Services 2008
  configuring 19-20
  configuring Web Server (IIS) role 15-17
  database security setup 51
Reporting Services 2008 (continued)
  configuring Web Server (IIS) for Reporting Services 2008 15-17
  installing 17-19
  integration with SharePoint 21
  setup checklist for Native mode 9
  Web Server (IIS) role, configuring for Windows Server 2008 15
Reporting Services 2008 add-in, for SharePoint 20
Reporting Services 2008 R2
  configuring 27-28
  configuring Web Server (IIS) role 23-26
database security setup 51
  granting access to reports 50
  installing 26-27
  integration with SharePoint 30
  setup checklist for Microsoft SharePoint 2010 11
  setup checklist for Native mode 10
  Web Server (IIS) role
    configuring for Windows Server 2008 16, 24
    configuring for Windows Server 2008 R2 25
Reporting Services 2008 R2 add-in, for SharePoint 29
Reporting Services 2012
  activating the Claims to Windows Token Service 41
  configuring in Native mode 36-37
  configuring in SharePoint Integrated mode 38-39
  configuring Web Server (IIS) role 32-35
  creating a Reporting Services service application 38
database security setup 51
  granting access to reports 50
  installing 35-36
  installing a Reporting Services SharePoint service 38
  integration with SharePoint 41
  setup checklist for Microsoft SharePoint 2010 13
  setup checklist for Native mode 12
  starting the Reporting Services SharePoint service 38
  Web Server (IIS) role
    configuring for Windows Server 2008 32
    configuring for Windows Server 2008 R2 33
    configuring for Windows Server 2012 34
Reporting Services 2012 add-in, for SharePoint 40, 41
Reporting Services integration
  activating 21
  configuring 21
  configuring for Microsoft SharePoint 2010 30, 41
Reporting Services reports
  deploying in Native mode 44
  deploying in SharePoint Integrated mode 46
Reporting Tools Setup window, using 43 reports
  access in Report Manager 49
  access in SharePoint 52
Reports Library, creating in Microsoft SharePoint 2010 29, 40
Reports site, creating in Microsoft SharePoint 2010 28, 39
requirements
  for Reporting Services 2008 installation 15
  for Reporting Services 2008 R2 installation 23
  for Reporting Services 2012 installation 31
Microsoft Dynamics GP CRM using SQL Server 2008 R2 23
Microsoft Dynamics GP CRM using SQL Server 2012 31

S
security
  designing for Reporting Services 49
  for databases
    group access to reports 51
    user access to reports 51
  in SharePoint 52
SharePoint
  access to reports 52
  Claims to Windows Token Service 41
  Reporting Services 2008 add-in 20
  Reporting Services 2008 integration 21
  Reporting Services 2008 R2 add-in 29
  Reporting Services 2008 R2 integration 30
  Reporting Services 2012 add-in 40, 41
  Reporting Services 2012 integration 41
  Reports Library in SharePoint 2010 29, 40
  Reports site in SharePoint 2010 28, 39
  security for Reporting Services 52
SharePoint 2010, creating permission levels 52
SharePoint 2010 groups
  access to a site 53
  adding users 54
  creating 53
SharePoint Integrated mode, deploying reports 46
SharePoint service
  creating a Reporting Services service application 39
  installing Reporting Services SharePoint service 38
SharePoint service (continued)
  starting the Reporting Services SharePoint service 38
SQL Server Reporting Services Add-in for Microsoft SharePoint Technologies, installing 20
SQL Server Reporting Services Add-in for SharePoint 2010 Technologies, installing 29, 40, 41
symbols, used in manual 2
T
timeout execution, modifying web.config file 43
W
Web Server (IIS) role
  configuring for Reporting Services 2008 15-17
  configuring for Reporting Services 2008 R2 23-26
  configuring for Reporting Services 2012 32-35
  Reporting Services 2008, configuring for Windows Server 2008 15
  Reporting Services 2008 R2
    configuring for Windows Server 2008 16, 24
    configuring for Windows Server 2008 R2 25
  Reporting Services 2012
    configuring for Windows Server 2008 32
    configuring for Windows Server 2008 R2 33
    configuring for Windows Server 2012 34
  Web site administrator, report access 49
  web.config file, modifying 43
Windows Server 2008
  Web Server (IIS) role for Reporting Services 2008 15
  Web Server (IIS) role for Reporting Services 2008 R2 24
  Web Server (IIS) role for Reporting Services 2012 32
Windows Server 2008 R2
  Web Server (IIS) role for Reporting Services 2008 16
  Web Server (IIS) role for Reporting Services 2008 R2 25
  Web Server (IIS) role for Reporting Services 2012 33
Windows Server 2012, Web Server (IIS) role for Reporting Services 2012 34